Configuration Policies Reference
ZENworks. 11 Support Pack 3

July 2014

Novell N



Legal Notices

Novell, Inc., makes no representations or warranties with respect to the contents or use of this documentation, and specifically
disclaims any express or implied warranties of merchantability or fithness for any particular purpose. Further, Novell, Inc.,
reserves the right to revise this publication and to make changes to its content, at any time, without obligation to notify any
person or entity of such revisions or changes.

Further, Novell, Inc., makes no representations or warranties with respect to any software, and specifically disclaims any
express or implied warranties of merchantability or fitness for any particular purpose. Further, Novell, Inc., reserves the right to
make changes to any and all parts of Novell software, at any time, without any obligation to notify any person or entity of such
changes.

Any products or technical information provided under this Agreement may be subject to U.S. export controls and the trade
laws of other countries. You agree to comply with all export control regulations and to obtain any required licenses or
classification to export, re-export or import deliverables. You agree not to export or re-export to entities on the current U.S.
export exclusion lists or to any embargoed or terrorist countries as specified in the U.S. export laws. You agree to not use
deliverables for prohibited nuclear, missile, or chemical biological weaponry end uses. See the Novell International Trade
Services web page (http://www.novell.com/info/exports/) for more information on exporting Novell software. Novell assumes
no responsibility for your failure to obtain any necessary export approvals.

Copyright © 2007 - 2014 Novell, Inc. All rights reserved. No part of this publication may be reproduced, photocopied, stored on
a retrieval system, or transmitted without the express written consent of the publisher.

Novell, Inc.

1800 South Novell Place
Provo, UT 84606

U.S.A.

www.novell.com

Online Documentation: To access the latest online documentation for this and other Novell products, see the Novell
Documentation web page (http://www.novell.com/documentation).

Novell Trademarks

For Novell trademarks, see the Novell Trademark and Service Mark list (http://www.novell.com/company/legal/trademarks/
tmlist.html).

Third-Party Materials

All third-party trademarks are the property of their respective owners.


http://www.novell.com/info/exports/
http://www.novell.com/info/exports/
http://www.novell.com/documentation
http://www.novell.com/documentation
http://www.novell.com/company/legal/trademarks/tmlist.html

Contents

About This Guide 7
1 Overview 9
1.1 What s @ PoliCY ? . . .. e 9
1.2 WhatIs @ Policy GroUpP? . .. ..o e e e 9
1.3 Understanding the PoliCY TYPES. . . . ..ot 10
1.4 Understanding the Features of a Policy. . .. ... .. 11
2 Creating Linux Configuration Policies 13
2.1 External Services PoOliCY. . .. ... 13
2.2 PUPPEt POLICY . . et 15
3 Creating Windows Configuration Policies 19
3.1 Browser Bookmarks POlICY . .. ... ... 19
3.2  Dynamic Local USer POIICY . . ... ...t e e e e e 21
3.2.1  Rules for Workstations. . . ...t 24
3.2.2 RUIES fOr USErS . . oo e 25
3.23 Implementing the Dynamic Local User Policy Without the Novell Client. .. ............ 26
3.3  Local File Rights PoliCY . . .. ..o 26
3.4 Power Management POIICY . .. ... ... 29
3.5 PHINtEr POICY . .o 31
3.6 Remote Management POlICY . . . ... ...t 37
3.7 Roaming Profile PoliCy . . .. ... 37
3.8  SNMP POlICY . .ottt e 38
3.9 WINdows Group PoliCy . . . ..o e 40
3.10 ZENworks Explorer Configuration Policy . . . . ... 43
3.11 Creating Policies by Using the zman Command Line Utility ... ......... ... .. ... .. ... .. .... 44
3.11.1 Creating a Policy without Content . . . . ... .. . 45
3.11.2 Creating a Policy with Content. . . .. ... .. a7
3.11.3 Understanding the zman Policy XML File Format . . ........... ... .. ... . v, 48
4 Managing Policies 51
4.1 Creating PoliCIes . .. .. 52
4.2 Viewing the PoliCy’'s SUMMaArY . . . ... . e e e 52
421 General ... 52
422 POliCY Status . . . .o 53
4.2.3 MESSAGE LOg . . - o v vttt et 54
4.3 POlICY GrOUPS. . . . ettt e et e 55
4.4 Editing PoliCIES. . . ..o 55
45 Deleting PoliCIES. . . . ..o e 56
4.6  Adding POlICIES 10 GrOUPS . . . .ttt et e e e e e e e e e 57
4.7  Assigning a Policy t0 DEVICES . . . .. oot 58
4.8  Assigning a Policy to USErS . . ... oo 59
4.9  Assigning a Roaming Profile Policy for a User Profile Stored on a Windows, Linux, or
NetWare Share. . . ... ..o 60

Contents

3



4

4.10
411
4.12
4.13
4.14

4.15
4.16
4.17
4.18

4.19
4.20
421
4.22
4.23
4.24

4.25

49.1 Creating a Default Profile Folder in a Shared Location . .. .........................
4.9.2 Creating the Default Profile from a Windows Vista, Windows 2008, or Windows 7

Device to the Default Profile Folder in the Shared Location ........................
49.3 Configuring the Permissions for the Default Profile Registry Hive. . . .................
4.9.4  Copying the Default Profileto User Folders ............ ... . ...
49.5 Configuring Novell Client 2 for WINdOWS 7 . . ... ..ot e
49.6 Enable Do not check for user Ownership of Roaming Profile Folders ................
Assigning a Roaming Profile Policy for a User Profile Stored on a Home Directory .............
Assigning the Local File Rights Policy to Devices Running Different Languages ...............
Unassigning a Policy from DeVICES . . .. ... ot
Unassigning a Policy from USers . . . ...ttt
Adding System Requirements fora Policy. ... ...
4.14.1  Filter ConditioNS. . .. ..ottt
4142 FIEr LOGIC . . o v v ottt e e e e
Disabling PoliCies . . . . . . e
Enabling the Disabled Policies. . . .. ... ...
Copying a Policy to @ CONtENt SEIVEN . . . . oot e
Publish @ PoOliCY . .. ..o
4.18.1 Publishas New Version. . . ...t e e
4.18.2 Publishas New PoOliCY . . ... ..o
Reviewing the Status of the Policies at the Managed Device ........... ... ... .. ... .......
Policy Issues on a Windows 7, Windows Server 2008, or Windows Server 2008 R2 device . . .. ..
Viewing the Predefined RepOrtS. . . ... .o
Understanding PoliCy VEISIONS. . . ... ..ot
Managing PoliCy VerSioNS . . .. ...
Publishing a SandboX . . ...
4.24.1 Publishing a Sandbox as a New Version. . . ...t
4.24.2 Publishinga SandboxasaNew Policy . . ........ ... .. ..
4.24.3 Publishing Multiple Sandbox as New Versions .. ...,
Policy Behavior Based on Content Replication Settings . .. ......... ... . . ...

5 Managing Policy Groups

51
5.2
5.3
54
55
5.6

Creating PoliCY GrOUPS . . . .o oot e e e e
Renaming or Moving PoliCY GrOUPS. . . . ..ttt e
Deleting @ POlICY GrOUD . . . . ..o o e e e e e e e
Assigning a Policy Group to DEVICES . . . . . .t
Assigning a Policy Group t0 USErS. . ... ..ot t  e eee ee
Adding a Policy 10 @ GroUD . ...t e

6 Managing Folders

6.1
6.2
6.3

Creating Folders. . . ... .o
Renaming or Moving Folders. . . ... ... e e e e
Deleting a Folder . . ... e

A Troubleshooting Policy Management

Al
A2
A3
A4
A5
A.6
A7

Browser Bookmarks POIICY EITOrS . . . . ... .
Browser Bookmarks Policy Troubleshooting . . ........ ... .. .
Dynamic Local User POIICY EITOrS . . . . ... . e e e
Dynamic Local User Policy Troubleshooting . . ........... .. s
General Policy Troubleshooting . .. ... ... e
Local File Rights POlICY EITOrS . . . ..ottt e
Local File Rights Policy Troubleshooting . .......... . e

ZENworks 11 SP3 Configuration Policies Reference

83

83
84
84
85
85
86

87

87
87
88



A.8  Printer Policy Errors . . ..o 100
A.9  Printer Policy Troubleshooting .. ... .. 102
A.10 Roaming Profile POliCY EITOrS . . ... .o 108
A.11 Roaming Profile Policy Troubleshooting . ............ . e 108
A12 SNMP PoliCY EITOrS . . o e e 109
A.13 WiIndows Group POIICY EITOrS . .. ..o e e e e e e e 110
A.14 Windows Group Policy Troubleshooting . ............ . . i e 113
A.15 ZENworks Explorer Configuration Policy Errors. . . ... ... 121
Best Practices 125
B.1 Local File Rights POlICY . . . ... . e 125
B.2 Dynamic Local User PoliCy . ... ... 125
B.3 Roaming Profile PoliCy . . . . ... 125
B.4d  SNMP POlICY . .ottt 125
B.5  WINdows Group PoliCY . . . . ..o 126
B.6  Printer POlCY . . ..o 126
iPrint Policy Management Utility 127
C.1 Installingthe IPPman Utility . . .. ... . 127
C.2  Using IPPman Commands to Configure iPrint Printers . ... . ... .. . . ., 128

C.2.1  Creating aniPrint Printer .. ... ... 128

C.2.2 Cloning aniPrint Printer .. ... ... ... 129

C.2.3 Renaming an iPrint Printer . ... ... . ... 130

C.24 Modifying an iPrint Printer . . .. ... . 131

C.25 Deleting an iPrint Printer . . ... ... e 132

C.2.6  Exporting iPrint Printer ... ... ... 132

C.2.7 Importing an iPrint Printer . ... ... . 133
C.3  Understanding the Format of the iPrint Printer Configuration File . .. ....................... 134

C.3.1  Format of iPrint Printer Configuration File with Default Printing Preferences .......... 134

C.3.2 [Example] iPrint Printer Configuration File with Some Printing Preferences Specified . . . 135
C.4  Printing Preferences for an iPrint Printer . . .. ... ... . e 135
C.5 iPrint Printer List Import File Format . ... ...... .. .. . . 136

Contents

5



6 ZENworks 11 SP3 Configuration Policies Reference



About This Guide

This Novell ZENworks 11 SP3 Configuration Management Policy Management Reference includes
information about Policy Management features and procedures to help you configure and maintain
your Novell ZENworks 11 SP3 Configuration Management system.

For information on policies that control a range of security-related functionalities for Windows devices
or help protect and configure the ZENworks Endpoint Security Agent, see the ZENworks 11 SP3
Endpoint Security Policies Reference.

For information on policies supplied by ZENworks Full Disk Encryption that are used to encrypt entire
disks (or volumes) for Windows devices, see the ZENworks 11 SP3 Full Disk Encryption Policy
Reference.

The information in this guide is organized as follows:

+ Chapter 1, “Overview,” on page 9

+ Chapter 2, “Creating Linux Configuration Policies,” on page 13

+ Chapter 3, “Creating Windows Configuration Policies,” on page 19
+ Chapter 4, “Managing Policies,” on page 51

+ Chapter 5, “Managing Policy Groups,” on page 83

+ Chapter 6, “Managing Folders,” on page 87

+ Appendix A, “Troubleshooting Policy Management,” on page 89

+ Appendix B, “Best Practices,” on page 125

+ Appendix C, “iPrint Policy Management Utility,” on page 127

Audience

This guide is intended for Novell ZENworks administrators.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation
included with this product. Please use the User Comments feature at the bottom of each page of the
online documentation.

Additional Documentation

ZENworks Configuration Management is supported by other documentation (in both PDF and HTML
formats) that you can use to learn about and implement the product. For additional documentation,
see the ZENworks 11 SP3 documentation Web site (http://www.novell.com/documentation/
zenworks113).
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1.2

Overview

Novell ZENworks 11 SP3 Configuration Management provides policies to configure operating system
settings and select application settings. By applying a policy to multiple devices, you can ensure that
all of the devices have the same configuration.

The following sections contain additional information:

¢ Section 1.1, “What Is a Policy?,” on page 9

+ Section 1.2, “What Is a Policy Group?,” on page 9

+ Section 1.3, “Understanding the Policy Types,” on page 10

+ Section 1.4, “Understanding the Features of a Policy,” on page 11

What Is a Policy?

A policy is a rule that controls a range of hardware and software configuration settings on the
managed devices. For example, an administrator can create policies to control browser bookmarks
available in the browser, printers to access, and security and system configuration settings on the
managed devices.

You can use the policies to create a set of configurations that can be assigned to any number of
managed devices. It helps you to provide the devices with a uniform configuration, and it eliminates
the need to configure each device separately.

You can assign a policy directly to a device or a user. You can also assign the policy to a folder or
group where the user or device is a member. Assigning a policy to device groups rather than device
folders is the preferred way, because a device can be a member of multiple device groups, but it can
be a member of only one device folder.

On managed devices, each policy type is enforced by a Policy Handler or Enforcer, which makes all
the configuration changes necessary to enforce or unenforce the settings in a given policy.

What Is a Policy Group?

A policy group is a collection of one or more policies. Creating policy groups eases the administration
efforts in managing policies. You can create policy groups and assign them to managed devices the
same way you would assign individual policies.

Because the policy inherits the group’s assignments, managing a policy group is easier than
managing individual policies. For example, if multiple policies are included in a policy group and the
policy group is assigned to a device or a device group, then all the policies included in the policy
group are automatically assigned to the device or device group at the same time. You need not
individually assign each policy to a device or a device group.

Overview
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1.3 Understanding the Policy Types

ZENworks 11 SP3 lets you create the following policy types:

+ Linux Configuration Policies: Lets you configure policies supplied by ZENworks Configuration
Management that are used to manage configuration settings for Linux devices. The following
policies are located in this category:

+ External Services policy
+ Puppet policy

+ Windows Configuration Policies: Lets you configure policies supplied by ZENworks
Configuration Management that are used to manage configuration settings for Windows devices.
The following policies are located in this category:

+ Browser Bookmarks policy

+ Dynamic Local User policy

+ Local File Rights policy

+ Power Management policy

+ Printer policy

+ Remote Management policy

+ Roaming Profile policy

+ SNMP policy

+ Windows Group policy

+ ZENworks Explorer Configuration policy

+ Windows Endpoint Security Policies: Lets you configure policies supplied by ZENworks
Endpoint Security Management that are used to manage security settings for Windows devices.
The following policies are located in this category:

+ Application Control policy

¢+ Communication Hardware policy
+ Data Encryption policy

+ Firewall policy

+ Location Assignment policy

+ Scripting policy

+ Security Settings policy

¢ Storage Device Control policy
+ USB Connectivity policy

+ VPN Enforcement policy

+ Wireless policy

The Windows Endpoint Security policies are not covered in this guide. For information about
these policies, see the ZENworks 11 SP3 Endpoint Security Policies Reference.

+ Windows Full Disk Encryption Policies: Lets you configure policies supplied by ZENworks
Full Disk Encryption that are used to encrypt entire disks (or volumes) for Windows devices. The
following policy is located in this category:

+ Full Disk Encryption policy

The Windows Full Disk Encryption policies are not covered in this guide. For information about
these policies, see the ZENworks 11 SP3 Full Disk Encryption Policy Reference.

10 ZENworks 11 SP3 Configuration Policies Reference
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1.4 Understanding the Features of a Policy

+ Apolicy is applied to a device or a user only if the policy is directly or indirectly associated to that
device or user.

The Browser Bookmarks policy, Dynamic Local User policy, Printer policy, Remote Management
policy, Windows Group policy, and ZENworks Explorer Configuration policy can be applied to a
device or a user:

The Local File Rights and SNMP policies can be applied only to a device.

The Roaming Profile policy can be applied only to a user.
+ A policy can be associated to groups and containers.

In ZENworks Control Center, devices and users can be organized by using containers and
groups. A device or user can be a member of multiple groups. The containers can be nested
within other containers. If a policy is associated to a group of users, it applies to all users in that
group. If a policy is associated to a user container, it applies to all users in the entire subtree
rooted at that container. The same behavior applies to device groups and containers.

+ A policy can be associated to query groups.

In ZENworks Control Center, the devices can also be members of query groups. Query groups
are similar to ordinary groups except that the membership is determined by a query defined by
the administrator. All devices that satisfy the query become members of that device group. The
query is evaluated periodically and the membership is updated with the results. An administrator
can configure the periodicity of the evaluation. An administrator can also force an immediate
refresh of a query group. Query groups act just like other groups where policies are concerned.

+ Policies are chronologically ordered by default.

When multiple policies are associated to a device, user, group, or container, the associations are
chronologically ordered by default. The administrator can change the ordering.

If a device or user belongs to multiple groups, the groups are ordered. Consequently, the policies
associated to those groups are also ordered. The administrator can change the ordering of
groups for a device or user at any time.

In addition, the policies in a policy group are ordered.

+ Policies have a precedence configured to determine the policy that is effective for a device or a
user.

Many policies of the same type can be applied to a user or a device through direct association
and inheritance. For example, if a Browser Bookmark policy is associated to a user and another
Browser Bookmark policy is associated to a container containing that user, the policy directly
associated to that user overrides the policy associated to the container.

+ Policies support management by exception.

You can define a global policy for your enterprise and associate it to the top-level container
containing all your user objects. You can then override configuration items in the global policy by
defining a new policy and associating it to specific users or user groups. These users receive
their configuration from the new policy. All other users receive their configuration from the global
policy.

+ Policies support system requirements.

You can specify the system requirements of a device or user in a policy. The policy is applied to
a device or user only if the device or user meets the system requirements.

For example, the SNMP policy is applied by default on all devices having the SNMP service
installed.

Overview 11



+ ZENworks Configuration Management supports singular and plural policies.

Singular Policy: If multiple policies of the same policy type are assigned to a device or a user
and the policy type is a Singular policy, then only the nearest associated policy meeting the
system requirements is applied. If the policy type is associated to both user and device, then two
different policies can be assigned to user and device.

The SNMP policy, Dynamic Local User policy, Remote Management policy, Roaming Profile
policy, Power Management policy, and ZENworks Explorer Configuration policy are singular
policies.

Plural Policy: If multiple policies of the same policy type are assigned to a device or a user and
the policy type is a Plural type, then all policies meeting the associated system requirement are
applied.

The Browser Bookmarks policy, Local File Rights policy, Windows Group policy, and Printer
policy are plural policies. However, the security settings in the Windows Group policy are not
plural.

+ Policies can be disabled.

When you create a policy in ZENworks Configuration Management, the policy is enabled by
default. You can disable it if you do not want to apply it on a user or a device.

+ ZENworks Configuration Management allows you to resolve policy conflicts.

The set of effective policies is a subset of the set of assigned policies. The set of effective
policies for a device or user is calculated by applying precedence rules, multiplicity rules, and
system requirements filters on the set of assigned policies. Effective policies are calculated
separately for devices and users. The Policy Conflict Resolution setting determines how user
and device policies interact for a specific user and device combination.

Effective policies are calculated separately for devices and users. When a user logs in to a
device, policies associated to both the user and the device must be applied. Policy Conflict
Resolution settings are used only when policies of the same type are associated to both the
device and the user. This setting determines the precedence order among the policies
associated to the user and those associated to the device. The Policy Conflict Resolution
settings are applied after the effective policies are calculated.

Policy Conflict Resolution settings are defined when associating a policy to a device. The
settings cannot be defined for associations to users. For each policy type, the Policy Conflict
Resolution setting defined in the closest effective policy of that type is applied for all policies of
that type.

A Policy Resolution Conflict setting can have one of the following values:

+ User Last: Applies the policies associated to the device first, then the policies associated to
the user. This is the default value.

+ Device Last: Applies the policies associated to the user first, then the policies associated to
the device.

+ User Only: Applies only the policies associated to the user and ignores the policies
associated to the device.

+ Device Only: Applies only the policies associated to the device and ignore the policies
associated to the user.

NOTE: The Policy Conflict Resolution setting is taken from the device-associated policy with the
highest precedence.

12 ZENworks 11 SP3 Configuration Policies Reference



2.1

Creating Linux Configuration Policies

Novell ZENworks 11 SP3 Configuration Management lets you create policies by using ZENworks
Control Center or by using the zman command line utility.

The following sections contain step-by-step instructions about creating the Linux configuration
policies by using ZENworks Control Center.
¢ Section 2.1, “External Services Policy,” on page 13

+ Section 2.2, “Puppet Policy,” on page 15

External Services Policy

The External Services policy lets you configure the external services on a Linux managed device for
YUM, ZYPP or MOUNT repositories. It enables you to download and install the software packages or
updates from these repositories on the managed devices.
1 In ZENworks Control Center, click the Policies tab.
2 In the Policies list, click New, then click Policy.
or
In the Policy Tasks, click New Policy.
The Select Platform page is displayed.
3 Select Linux, then click Next.
The Select Policy Category page is displayed.
4 Select Linux Configuration Policies, then click Next.
5 Select External Services Policy as the Policy Type, then click Next.
6 In the Define Details page fill in the following fields:

Policy Name: Provide a name for the policy. The policy name must be different from the name
of any other item (group, folder, and so forth) that resides in the same folder. The nhame you
provide displays in ZENworks Control Center.

Folder: Type the name or browse to and select the ZENworks Control Center folder where you
want the policy to reside. The default is /Policies, but you can create additional folders to
organize your policies.

Administrator Notes: Provide a short description of the policy’s content. This description
displays in ZENworks Control Center.

7 Click Next to display the External Services Policy page.
8 In the External Services Policy page, click Add to display the External Services Policy dialog box.
9 The following table lists the tasks you can perform in the External Services policy dialog box.

Creating Linux Configuration Policies 13
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Task Steps Additional Details
Add an External 1. Click Add to display the External Services The available repository types
Service Policy dialog box. are AUTO, ZYPP, YUM, and
2. Specify the name of the service, the URL MOUNT.
for th_e service, and the type of re_posito_ry AUTO is a default repository
to which you wan.t to add the service. Click type, if selected, the system
Help.for |pformat|on on how to fill the automatically detects either
required fields. ZYPP or YUM as the type of
3. Select the checkbox Recursive to add repository.
services on the managed device for the . o
Romps present under all the The _credentlal option is not
subdirectories of the specified URL. The  &pPplicable to the MOUNT
recursive property is applicable only to the SErVICe type.
MOUNT service type.
4. For External Services that require
authentication, click |&] to browse to and
select an existing credential from the
Credential Vault.
5. Select the check box Synchronize with
External Package Management Tools, to
synchronizes the External Services with
the package management tools.
6. Click OK.
Edit an External 1. Select the External Service you want to The service name and recursive
Service edit, then click Edit. property once specified cannot
2. Follow the online prompts to make be edlted._ T_O edit th_ese options
for the existing service, remove
changes. .
_ the service and add a new
3. Click OK. External Service.
Remove an External 1. Select one or more External Services that
Service you want to remove, then click Remove.

10 Review the information on the Summary page and, if necessary, use the Back button to make
changes to the information on the Summary page.

11 (Conditional) Select Create as Sandbox, if you want to create the sandbox version of the policy.

12 Select the check box for Define Additional Properties.

13 Click Finish to create the new External Services policy.

14 Click Relationships and assign the newly created External Services policy to a test device and a

non-test device.

NOTE

If you disable the Bundle Management module, services that are a part of the External Services
policy do not flow down to the agent.
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2.2 Puppet Policy

The Puppet policy lets you apply the Linux configuration on the Linux devices.

1 In ZENworks Control Center, click the Policies tab.
2 In the Policies list, click New, then click Policy.
or
In the Policy Tasks, click New Policy.
The Select Platform page is displayed.
3 Select Linux, then click Next.
The Select Policy Category page is displayed.
4 Select Linux Configuration Policies, then click Next.
5 Select Puppet Policy as the Policy Type, then click Next.
6 In the Define Details page fill in the following fields:

Policy Name: Provide a name for the policy. The policy name must be different from the name
of any other item (group, folder, and so forth) that resides in the same folder. The name you
provide displays in ZENworks Control Center.

Folder: Type the name or browse for and select the ZENworks Control Center folder where you
want the policy to reside. The default is /Policies, but you can create additional folders to
organize your policies.

Administrator Notes: Provide a short description of the policy’s content. This description
displays in ZENworks Control Center.

7 Click Next to display the Puppet Policy page. You can create a puppet policy to run scripts as
either Manifest or Module.

The following options lets you run puppet scripts on a managed device, upload the script file, and
specify if a dry run on the script should be performed.

+ Run Script As: You can create a policy to run script as either Manifest or Module.

+ FileName: Depending on your selection to run the script as Manifest or Module, browse for
and upload the script file in the following formats:

Manifest: Upload a .pp file.
Module: Upload a .zip, -tar, -tar.gz, .tar.bz2, .tgz, or .tbz2 file.

NOTE: After creating either Manifest or Module on a Windows operating system, run the
dos2unix command on the puppet script file, to avoid parsing errors on the managed
device.

+ Dry Run: Select this option to have ZENworks Configuration Management perform a test to
determine if the Puppet policy can be successfully enforced on a managed device.

If there are any issues that could prevent the policy from being enforced, you can view the
issues in the log file created to troubleshoot the policy creation process. The log file is
located at /var/opt/novel 1/1og/zenworks/puppet. log. A successful dry run ensures
that the policy can be successfully enforced on the managed device.

+ Advanced Options: Select this option to specify the Puppet Command Options.

The Run Puppet Command As field displays the puppet command that will be run on the
managed device. The command consists of the following two parts:

Part 1:

Creating Linux Configuration Policies 15



Includes the non-editable part of the command as follow:
/opt/novell/zenworks/bin/puppet script_name --noop

/opt/novel 1/zenworks/bin/puppet is the portion of the command that is displayed by
default. Based on your choice to run the script as a manifest or a module, the script_name
parameter is replaced by the name of the manifest file or the module name. If the Dry Run
option is enabled, then --noop string gets appended to the command.

Part 2:

Includes the editable part of the command. The following portion of the command is
displayed by default:

-dv --detailed-exitcodes --confdir /etc/opt/novell/zenworks/puppet -1 /var/
opt/novell/1og/zenworks/puppet. log

For information on the parameters used in the command, see the following table:

Parameter Description

d Enables full debugging.

\Y Prints extra information.

detailed-exitcodes Provides transaction information through exit
codes.

| Creates a log file.

log_file_path Path of the log file, the default path is
/var/opt/novell/log/zenworks/
puppet. log.

--confdir Is the Puppet Configuration Directory.

You can choose to edit this portion of the command as in the following examples.
Example 1:

The default log path is /var/opt/novel 1/1og/zenworks/puppet. log. However, you can
choose to specify a different log file such as a /tmp/puppet.log using the following
command.

/opt/novel l/zenworks/bin/puppet script_name --noop -dv --detailed-exit
codes --confdir /etc/opt/novell/zenworks/puppet -1 /tmp/puppet.log

Example 2:

The default puppet configuration file is /etc/opt/novel 1/zenworks/puppet/
puppet.conf. However, you can choose to specify a different configuration file as follows:

/opt/novell/zenworks/bin/puppet script_name --noop --config=/tmp/
mypuppet.conf -1 /tmp/puppet.log

The availability of the supported parameters is dependent on the version of the puppet installed on
the managed device.

8 Review the information on the Summary page and, if necessary, use the Back button to make
changes to the information on the Summary page. In the Summary page the Module file content
displays the list of files that are packaged as either Module or Manifest.

9 (Conditional) Select Create as Sandbox, if you want to create the sandbox version of the policy.
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10 Select the check box for Define Additional Properties.
11 Click Finish to create the new Puppet policy.

12 Click Relationships and assign the newly created Puppet policy to a test device and a non-test
device.
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3.1

Creating Windows Configuration
Policies

Novell ZENworks 11 SP3 Configuration Management lets you create policies by using ZENworks
Control Center or by using the zman command line utility.

The following sections contain step-by-step instructions about creating the Windows Configuration
policies by using ZENworks Control Center:

+ Section 3.1, “Browser Bookmarks Policy,” on page 19

+ Section 3.2, “Dynamic Local User Policy,” on page 21

+ Section 3.3, “Local File Rights Policy,” on page 26

+ Section 3.4, “Power Management Policy,” on page 29

+ Section 3.5, “Printer Policy,” on page 31

+ Section 3.6, “Remote Management Policy,” on page 37

+ Section 3.7, “Roaming Profile Policy,” on page 37

+ Section 3.8, “SNMP Policy,” on page 38

+ Section 3.9, “Windows Group Policy,” on page 40

+ Section 3.10, “ZENworks Explorer Configuration Policy,” on page 43

NOTE: A Dynamic Local User (DLU) policy, Windows Group policy, and Roaming Profile policy
cannot be used on a device that has Citrix XenApp 6.5, Citrix XenDesktop, or VMware VDI installed
because Novell client login is not involved when it is launched.

The following section explains how to create policies by using the zman command line utility:

+ Section 3.11, “Creating Policies by Using the zman Command Line Utility,” on page 44

Browser Bookmarks Policy

The Browser Bookmarks policy lets you configure Internet Explorer favorites for Windows devices
and users.
1 In ZENworks Control Center, click the Policies tab.
2 In the Policies list, click New, then click Policy.
or
In the Policy Tasks, click New Paolicy.
The Select Platform page is displayed.
3 Select Windows, then click Next.
The Select Policy Category page is displayed.
4 Select Windows Configuration Policies, then click Next.
5 Select Browser Bookmarks Policy as the Policy Type, then click Next
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6 In the Define Details page fill in the following fields:

Policy Name: Provide a name for the policy. The policy name must be different than the name of
any other item (group, folder, and so forth) that resides in the same folder. The name you provide
displays in ZENworks Control Center.

Folder: Type the name or browse to and select the ZENworks Control Center folder where you
want the policy to reside. The default is /policies, but you can create additional folders to
organize your policies.

Administrator Notes: Provide a short description of the policy’s content. This description
displays in ZENworks Control Center.

7 Click Next to display the Bookmarks Tree Data Source page.

8 Create a browser bookmarks tree by importing a previously exported file or manually entering
the data. Before you import a book marks file ensure that it is in UTF-8 format. To manually
convert the bookmark file into UTF-8 format, use a text editor

The following list contains browser-specific information to create the exported file:

+ Internet Explorer 8.x/9.x: In the browser window, click File > Import and Export. Follow the
instructions given in the Import/Export Wizard to create the bookmark.htm file.

+ Mozilla Firefox 3.x: In the browser window, click Bookmarks > Organize Bookmarks, then
click Import and Backup > Export HTML to create the bookmarks.html file.

+ Mozilla Firefox 4.x to 10.x: In the browser window, click Bookmarks > Show All
Bookmarks to open the library. From the toolbar on the library, click Import and Backup >
Export Bookmarks to HTML to create the bookmarks.html file.

9 Click Next to display the Bookmarks Tree Configuration page, then use the options to configure
the bookmarks tree.

The following table lists the tasks you can perform with the New, Edit, and Delete options.

Field Details

New + Click New > Folder to display the Add Folder to Bookmarks dialog box, through which
you can add a new folder to the bookmarks tree.

+ Click New > Bookmark to display the Add Bookmark to Bookmarks dialog box, through
which you can add a new bookmark to the bookmarks tree by specifying the bookmark
name and a URL. Click the button next to the URL field to verify that the URL entered
by you is correct and functional.

Edit + Select the bookmark name you want to change, click Edit > Rename, then specify a
new name.
+ Click Edit > Sort to organize the bookmarks in ascending or descending order.
+ Click Edit > Move Up, Move Down, or Move To to relocate a bookmark.

+ Click Edit > Select All Children > to select all the subdirectories and bookmarks of the
selected parent directory.

+ Click Edit > Deselect All Children > to deselect all the subdirectories and bookmarks of
the selected parent directory.

+ Click Edit > Clear Selection > to clear the selections.
Delete * Click Delete to delete the selected bookmarks and the bookmarks folder from the

bookmarks tree. However, you cannot delete the default bookmarks folder named
Bookmarks.

10 Review the information on the Summary page and, if necessary, use the Back button to make
changes to the information on the Summary page.
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11 (Conditional) Select Create as Sandbox, if you want to create the sandbox version of the policy.

12 Click Finish to create the policy now, or select Define Additional Properties to specify additional
information, such as policy assignment, system requirements, enforcement, status, and which
group the policy is a member of.

Dynamic Local User Policy

The Dynamic Local User policy lets you create new users and manage existing users on the
managed device after they have successfully authenticated to user source.

NOTE:

+ |tis recommended that you install the latest version of the Novell Client on the managed device
before the Dynamic Local User policy is enforced. To obtain the latest version of Novell Client,
see the Novell Download Web site (http://download.novell.com/index.jsp).

+ To implement the Dynamic Local User policy without the Novell Client, see Section 3.2.3,
“Implementing the Dynamic Local User Policy Without the Novell Client,” on page 26.

+ Dynamic Local User policy is not supported for Domain Services for Windows (DSfW) users.

1 In ZENworks Control Center, click the Policies tab.
2 In the Policies list, click New, then click Policy.
or
In the Policy Tasks, click New Policy.
The Select Platform page is displayed.
3 Select Windows, then click Next.
The Select Policy Category page is displayed.
4 Select Windows Configuration Policies, then click Next.
5 Select Dynamic Local User Policy as the Policy Type, click Next.
6 In the Define Details page fill in the following fields:

Policy Name: Provide a name for the policy. The policy name must be different than the name of
any other item (group, folder, and so forth) that resides in the same folder. The name you provide
displays in ZENworks Control Center.

Folder: Type the name or browse to the ZENworks Control Center folder where you want the
policy to reside. The default is /policies, but you can create additional folders to organize your
policies.

Administrator Notes: Provide a short description of the policy’s content. This description
displays in ZENworks Control Center.

7 Click Next to display the User Configurations page, then use the options on the page to
configure the user account.

The following table contains information about configuring dynamic local user accounts and
managing them on managed devices:

Field Details
Use User Source Enables logging in through the user source credentials instead of the
Credentials Windows Operating System credentials.

Creating Windows Configuration Policies 21


http://download.novell.com/index.jsp

Field

Details

Use the Credentials
Specified Below (Always
volatile)

Manage Existing User
Account (if any)

Volatile User

Enable Volatile User
Cache

If you do not select Use User Source Credentials, the user account that is
created is always volatile and is not accessible. This setting allows you to
specify the following user credentials for a volatile user:

+ User Name: Specify the user’s name.
+ Full Name: Specify the user’s complete name.

+ Description: Provide any additional information that helps the
administrator to further identify this user account.

+ Use User Source Password: Select this option to create the account
with the password configured in the user source. Ensure that you enable
the setting Manage Existing User Account (if any). If both settings are
enabled, a user who has logged into the workstation at least once, can
login locally on the workstation and access it even in case of network
logon failure.

If a user logs in to a device that has the Dynamic Local User policy applied
and then logs out of the device when the device is disconnected from the
network, the user is unable to log in to the disconnected device again. For
information on this issue, see “Dynamic Local User Policy Troubleshooting” on
page 92.

Helps you to manage a user object that already exists.

If you select both the Volatile User and the Manage Existing User Account (If
Any) check boxes, and the user has a permanent local account that uses the
same username specified in the user source, the permanent account is
changed to a volatile (temporary) account and is removed when the user logs
out.

If a local user object already exists with a DLU user name, any changes to the
DLU user name cannot be applied on the policy unless you enable Manage
Existing User Account (if any). This setting must be enabled for the following
scenarios to work:

+ Manually changing the user password.
+ Changing the user e-directory password.
+ Applying updated settings if the local user account is present on the

device.

Specifies the use of a volatile user account for login. The user account that
NWGINA creates on the local workstation can be either a volatile or a
nonvolatile account.

Enables the caching of the volatile user account on the device for a specified
period of time.

If the Enable Volatile User Cache setting is set in disconnected mode, the
following are possible:

+ On a device that has Novell Client installed, the last logged in user can
log in to the system locally.

+ If you have enabled ZENworks GINA to use DLU without the Novell
Client, then any previously logged in cached user can log in to the
system locally.
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Field Details

Cache Volatile User for  Allows you to specify the number of days to cache the volatile user account on
Time Period (Days) the device. The default value is 5. You can specify a value from 1 to 999 days.

This volatile user account is deleted after the expiry of the specified cache
period when another DLU user logs out from the device.

Not a Member Of Displays the available group to which a user can be assigned as a member.
Member Of Displays groups a user is member of.
Custom Click Custom to display the Custom Group Properties dialog box, through

which you can add a new custom group and configure its rights.

Edit Click Edit to view and edit the details of a custom group. You cannot edit the
default Windows groups with this option.

Delete Click Delete to delete a custom group. You cannot delete the default Windows
groups with this option.

Click Next to display the Login Restrictions page, then fill in the fields to configure user access:

+ Included / Excluded Users: Lists the users and containers that you want to include or
exclude access to. For more information, see “Rules for Users” on page 25.

+ Included / Excluded Workstations: Lists the workstations and containers that you want to
include or exclude access to. For more information, see “Rules for Workstations” on
page 24.

The Excluded Workstations List displays the workstations and containers that you want to
exclude DLU access to. Workstations listed or workstations that are in the containers listed here
cannot use DLU access. You can make exceptions for individual workstations by listing them in
the Included Workstations List. This allows DLU access to those workstations only, and excludes
DLU access to the remaining workstations in the container. If the user account is already on the
workstation, the option to exclude the device from receiving the DLU policy is ignored.

Click Next to display the File Rights page.

For a DLU Paolicy, the timeout duration for enforcing file rights, if it is configured, is 120 seconds.
For large directory structures, the DLU policy might not be enforced because of a time out. To
enforce the file rights, follow instructions in TID 7004171, in the Novell Support Knowledge base
(http://www.novell.com/support/search.do?usemicrosite=true&searchString=7004171).

The following table contains information about managing Dynamic Local User file system access
on the managed device:

Field Details

Add Allows you to select and assign appropriate file rights.

To add a file/folder:
1. Click Add, then specify a file or folder.
2. Select the file rights you want to assign to the specified file or folder.

3. If you want to restrict the inheritance of the rights to only the immediate child file or
folder, select Restrict inheritance to immediate child files/folders only.

4. Click OK.
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Field Details

Edit Copy: Allows you to copy and add a file rights setting to the list.
1. Select a file or folder, then click Edit.
2. Click Copy.
3. Specify a new name.
4. Click OK.

Rename: Allows you to edit only the filename.
1. Select a file or folder, then click Edit.
2. Click Rename.
3. Specify a new filename.
4. Click OK.

Move Up or Allows you to reorder the files or folders.

Move Down 1. Select the check box next to the file or folder you want to move.
2. Click Move Up or Move Down to relocate it.
Remove Allows you to remove a file or a folder from the list.

1. Select the check box next to the file or folder.

2. Click Remove.

10 Click Next to display the Summary page. Review the information and, if necessary, use the Back
button to make changes to the information on the Summary page.

11 (Conditional) Select Create as Sandbox, if you want to create the sandbox version of the policy.

12 Click Finish to create the policy now, or select Define Additional Properties to specify additional
information, such as policy assignment, system requirements, enforcement, status, and which
group the policy is a member of.

3.2.1 Rules for Workstations

24

Be aware of the following:

+ By default, all workstations are included.

+ For an indirect association, if an object is in both lists, the closeness of the association is
considered. A direct association is closer than a group association, which in turn is closer than a
folder.

+ |f the closeness is the same, a workstation is directly added to Group A and Group B, and the
Included List takes precedence.

Excluded List Included List Result

Workstation-A Workstation-B The policy is applied on all
workstations except Workstation-
A.
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Excluded List Included List

Result

Workstation Group-1 Workstation-A

Container-1 Workstation Group-1 or
Workstation-A

The policy is not applied on any
workstations in Workstation
Group-1, except for Workstation -
A.

The policy is applied on
workstations that are not
contained in Workstation Group-1.

The policy is not applied on any
workstations in Container-1,
except for Workstation Group-1 or
Workstation-A.

The policy is also applied on
workstations that are not
contained in Container-1.

3.2.2 Rules for Users

Be aware of the following:

+ By default, all users are included.

+ For an indirect association, if an object is in both the lists, the closeness of the association is
considered. A direct association is closer than a group association, which in turn is closer than a

folder.

+ |f the closeness is the same, a user is directly added to Group A and Group B, and the Included

List takes precedence.

Excluded List Included List

Result

User-A User-B

User Group-1 User-A

Container-1 User Group-1 or User-A

The policy is applied on all users
except User-A.

The policy is not applied on any
users in User Group-1, except for
User -A.

The policy is also applied on
users that are not contained in
User Group-1.

The policy is not applied on any
users in Container-1, except for
User Group-1 or User-A.

The policy is also applied on
users that are not contained in
Container-1.
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3.2.3

Implementing the Dynamic Local User Policy Without the
Novell Client
To log a dynamic user with an e-directory account into a workstation using the Dynamic Local User
policy:

1 Install the ZENworks Adaptive Agent on the workstation.

2 After successful installation, create a DWORD value AllowDLUWithoutNovel ICIient under the

following registry key and set its data to 1:

Windows XP (32-bit): HKEY_LOCAL_MACHINEN\SOFTWARE\\Nove I IN\NWG INA

For this registry key to be effective, it is mandatory that you reboot the Windows XP device.
Windows Vista (32-bit and 64-bit):

HKEY_LOCAL_MACH INEN\SOFTWARE\\Novel IN\\Authentication

Windows 7 (32-bit and 64-bit):

HKEY_LOCAL_MACH INEN\SOFTWARE\\Novel IN\\Authentication

This support is not available on managed devices running Windows Server operating systems.

NOTE: In Windows Vista or Windows 7, if the initial login screen does not have an option to
enter the username, then do one of the following:

1. Enable the following setting from the Local Security policy:
a. Launch secpol.msc.
b. Navigate to Security Settings > Local Policies > Security Options.
c. Enable Interactive Logon: > Do not display last user name.
or

2. Create the following registry key
[HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\Sys
tem] dontdisplaylastusername ?=dword:00000001

For more information on the Registry key see, ZENworks 11 SP3 Registry Keys Reference.

Create a user source on the ZENworks server, assuming the user source has one user with the
credentials admin/novell.

Log in to the workstation using user-source credentials (admin/novell).

A Dynamic Local User account gets created.

IMPORTANT:

+ If the DLU policy is created to take the credentials other than the user-source credentials, a
DLU user fails to unlock the workstation.

3.3 Local File Rights Policy

The Local File Rights policy allows you to configure rights for files or folders that exist on the NTFS
file systems.

1 In ZENworks Control Center, click the Policies tab.
2 In the Policies list, click New, then click Policy.

or
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In the Policy Tasks, click New Policy.

The Select Platform page is displayed.

Select Windows, then click Next.

The Select Policy Category page is displayed.

Select Windows Configuration Policies, then click Next.

5 Select Local File Rights Policy as the Policy Type, then click Next

In the Define Details page fill in the following fields:

Policy Name: Provide a name for the policy. The policy name must be different than the name of
any other item (group, folder, and so forth) that resides in the same folder. The name you provide
displays in ZENworks Control Center.

Folder: Type the name or browse to and select the ZENworks Control Center folder where you
want the policy to reside. The default is /policies, but you can create additional folders to
organize your policies.

Administrator Notes: Provide a short description of the policy’s content. This description
displays in ZENworks Control Center.

Click Next to display the Configure Basic Properties page, then use the options on the page to
configure the attributes.

The following table contains information about configuring a file or folder and the attributes
associated with it:

Field Details

File / Folder Path  Allows you to specify the complete path of a file or folder on the managed device. You
can use the ZENworks system variables or environment variables to specify the path.

To configure system variables in ZENworks Control Center, click the Configuration tab
> the Device Management setting in the Management Zone Settings panel > System
Variables. Click the Help button for details about configuring system variables.

Notify if the file or When you select this option, a message is sent to the Primary Server. If a folder
folder does not entered by the user is not present on the ZENworks Adaptive Agent, then the policy
exist fails to enforce on the managed device.

If you de-select this option, even if a folder is not present on the ZENworks Adaptive
Agent, a message will not be sent to the Primary Server and the policy will be
enforced successfully on the managed device.

Attributes Allows you to specify the attributes of a file or folder, such as Read only and Hidden.

This page allows you to configure permissions for only one file or folder. If you want to assign
permissions to multiple files or folders, then configure them in the Details page after creating the

policy.
Click Next to display the Configure Permissions page, then use the options on the page to
configure permissions for selected users or groups.

The following table contains information about configuring permissions:
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Field

Details

Permission for
Users or Groups

Create Groups on
the Managed
Device if they Do
not Exist

Remove Access
Control Rules not
Configured by
ZENworks

Inherit Applicable
Access Rights
Configured on
Parent Folders

Allows you to configure permissions for users or groups.

1. Click Add, then Click User or Group to select a user or a group from the
appropriate drop-down list.

2. Select the type of permission you want to configure as Simple NTFS
Permissions or All NTFS Permissions. Depending on the type of permission
you select, a list of permissions are displayed. Configure the permissions as
applicable to the selected user or group.

3. By default, when a permission is set on a folder, all the subfolders and the files
also inherit the permissions. If you want to restrict the inheritance of the rights
to only the immediate child file or folder, select Restrict inheritance to
immediate child files/folders only.

4. Click OK.

The permissions configured for the user or group in the Dynamic Local User policy
takes precedence over the permissions configured in the Local File Rights policy.

Creates a group for which permissions are configured; however the group does not
exist on the managed device. With this option, you can create only local groups.

Removes all access control entries for users or groups not configured by the
ZENworks Local File Rights policy. Also, updates the existing access control entries
for users and groups configured in the policy. After the policy is applied, any manual
changes made to the permissions for a user or group configured by the policy are
lost when the policy is re-applied.

Select Yes if you want a file or folder to inherit applicable access control rules from
its parent object. If you select No, inherited rules are removed. If you do not want to
make any changes, select not configured on the managed device.At least one
attribute, permission, or inheritance setting must be configured to create a policy.
Without configuring any settings, you cannot create a policy.

NOTE: If the Full Control access right is denied for the Administrators or Authenticated Users
group, the policy is successful only during the first enforcement. However, if the Full Control
access right is denied for the Administrators or Authenticated Users group and the Remove
access control rules not configured by ZENworks option is selected, the policy fails.

The unenforcement of the Local File Rights policy from a device fails if the Full Control access
right is denied for the Administrators or Authenticated Users group in the policy.

Click Next to display the Summary page. Review the information and, if necessary, use the Back
button to make changes to the information on the Summary page.

(Conditional) Select Create as Sandbox, if you want to create the sandbox version of the policy.

Click Finish to create the policy now, or select Define Additional Properties to specify additional
information, such as policy assignment, system requirements, enforcement, status, and which
group the policy is a member of.
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Power Management Policy

The Power Management policy allows you to configure the Power Management settings on the
managed devices by creating a power scheme. It lets you configure the plugged in and battery power
management settings and assign them to a device or a user.
1 In ZENworks Control Center, click the Policies tab.
2 In the Policies list, click New, then click Policy.
or
In the Policy Tasks, click New Policy.
The Select Platform page is displayed.
3 Select Windows, then click Next.
The Select Policy Category page is displayed.
4 Select Windows Configuration Policies, then click Next.
5 Select Power Management Policy as the Policy Type, then click Next.
6 In the Define Details page fill in the following fields:

Policy Name: Provide a name for the policy. The policy name must be different than the name of
any other item (group, folder, and so forth) that resides in the same folder. The name you provide
displays in ZENworks Control Center.

Folder: Type the name or browse to and select the ZENworks Control Center folder where you
want the policy to reside. The default is /policies, but you can create additional folders to
organize your policies.

Administrator Notes: Provide a short description of the policy’s content. This description
displays in ZENworks Control Center.

7 Click Next to configure the power settings for a managed device.
8 In the Add Power Scheme Settings page fill in the following fields:

Scheme Name: The policy name specified on the Define Details page is automatically
displayed. You can either retain the policy name for the scheme or specify a new scheme name.
ZENworks 11 creates a scheme with the specified name on the managed device.

Scheme Description: Provide a description for the power scheme. The description is displayed
as a tooltip for the power scheme on the managed device.

Power Settings: To add power scheme settings to a device or user, refer to the following table:

Task Description

Turn off hard disk after How long your hard disk is inactive before the disk turns off.

Slide show The duration for which you want the desktop background slide show to
be active.

Power saving mode The power saving mode for a wireless adapter.

Sleep after How long your computer will be inactive before switching to sleep
mode.

Allow hybrid sleep If your system needs to save work it can, enter a low power state and

resume work immediately.

Enable System Hibernation If system hibernation is enabled or not.
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Task

Description

Hibernate after

Allow wake timer

USB selective suspend setting

Lid close action

Power button action
Sleep button action

Link state

Minimum processor state
System cooling policy
Maximum processor state
Dim display after

Turn off display after
Display brightness
Dimmed display brightness
Enable adaptive brightness
When sharing media

When playing video

JavaScript timer frequency

Critical battery action

Low battery level

Critical battery level

Low battery notification

Low battery action

Reserve battery level

How long your system will be inactive before switching to hibernate
mode.

If timed events should change the state of the computer from sleep
mode to active mode.

If the USB selective suspend feature is turned Off or On.

The action that the computer takes when you close the lid of your
mobile-PC.

The action to be taken when you press the Power button.
The action to be taken when you press the Sleep button.

The Active State Power Management mode to be used for PCI
Express-based serial links when the links are idle or less active.

The minimum performance state of your processor.

The cooling mode for your system.

The maximum performance state of your processor.

How long your system is inactive before the display dims.
How long your system is inactive before the display turns off.
The normal brightness level of your system.

The display brightness when your monitor display is dimmed.
If your monitor supports adaptive brightness.

What your computer does when sharing media files.

The power optimization mode used by your computer's video
playback pipeline.

The power optimization mode used by your computer for Internet
Explorer 9 and Internet Explorer 10 browsers.

The action that your computer takes when the battery reaches the
critical level.

The percentage of battery capacity remaining that initiates the low
battery action.

The percentage of battery capacity remaining that initiates the critical
battery action.

Whether a notification is shown when the battery capacity reaches the
low level.

The action that your computer takes when battery capacity reaches
the low level.

The percentage of battery capacity remaining that initiates reserve
power action.
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NOTE:

. We recommend that you configure the power scheme duration in the following
descending order: System Hibernation > System Standby > Hard Disks > Monitor.

. The values of System Standby and System Hibernation are interdependent. If you
choose to set the state of these settings to Not Configured, in such a case, the other setting
can only be set to either Never or Not Configured. This is to ensure that the 'Standby
Timeout' is always lesser than the 'Hibernate Timeout'.

For example, if you set a duration for the System Standby value and then set the System
Hibernation value to Not Configured, the System Standby value automatically changes to
Not Configured.

. When you apply power management settings on a Windows XP managed device, the
scheme name is displayed in the settings panel of the Windows Power Options console
only for a system user.

Printer Policy

The Printer policy allows you to configure Local, SMB, HTTP, TCP/IP, CUPS, and iPrint printers on a
Windows device.

NOTE: On a 32-bit agent machine, when the iPrint printer is installed through a user assigned printer
policy, you will not be able to view the printer preferences or properties.

1 In ZENworks Control Center, click the Policies tab.
2 In the Policies list, click New, then click Policy.

or

In the Policy Tasks, click New Policy.

The Select Platform page is displayed.
3 Select Windows, then click Next.

The Select Policy Category page is displayed.
4 Select Windows Configuration Policies, then click Next.
5 Select Printer Policy as the Policy Type, then click Next.
6 In the Define Details page fill in the following fields:

Policy Name: Provide a name for the policy. The policy name must be different than the name of
any other item (group, folder, and so forth) that resides in the same folder. The name you provide
displays in ZENworks Control Center.

Folder: Type the name or browse to and select the ZENworks Control Center folder where you
want the policy to reside. The default is /policies, but you can create additional folders to
organize your policies.

Administrator Notes: Provide a short description of the policy’s content. This description
displays in ZENworks Control Center.

7 Click Next to display the Printer Identification page, then select the type of printer to be installed
on the managed device.

8 Click Next, then skip to the appropriate step, depending on which printer type you chose in
Step 7:

+ Local Printer: Continue with Step 9.
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+ Network Printer: Skip to Step 10.
+ iPrint Printer: Skip to Step 11.

NOTE: Create and assign separate policies for different platforms for a printer.

9 (Conditional) If you are configuring a local printer, refer to the following table for more
information:

Field Details

Name Specify the name of the local printer that you want to configure on the target
device.

Driver Browse to and select a suitable driver for the printer. If the driver is not contained
in the browser list, type in the correct model name. The driver must either be
installed on the target device or specified in the enforced policies. The driver
must be digitally signed by Microsoft. However, if you choose to use a driver that
is not digitally signed, see the Troubleshooting Scenario.

Port Select the physical port to which the printer is added, such as LPT1, COM1 or
Standard TCP/IP.

NOTE: If you assign a TCP/IP Printer policy to a 11 SP1 or older version of the
agent, the policy gets applied and then fails and sends errors to the server at
every refresh, as it is not supported.

Remove the association with the lower version of the agents from the TCP/IP
printer policy, to prevent it from being applied at every refresh.

IP Address Specify the IP address of the local printer. This field appears only if you select
Standard TCP/IP as the port.

Protocol Specify the protocol of the local printer. You can select either RAW or LPR from
the drop-down options. This field appears only if you select Standard TCP/IP as
the port.

Port Number Specify the port number for the protocol. Typically the port number is 9100. This
field appears only if you select the RAW protocol on the Standard TCP/IP
settings page.

Queue Name Specify the queue name to be used by this port, if a name is required by your
printer. This field appears only if you select the LPR protocol on the Standard
TCP/IP settings page.

LPR Byte Counting Choose this option if you encounter problems such as missing or incomplete

Enabled documents when printing. When LPR byte counting is enabled, the system
counts the number of bytes in a document before processing the print request.
Most printers do not need byte counting enabled because it can be very time
consuming. This field appears only if you select the LPR protocol on the
Standard TCP/IP settings page.

SNMP Status Enabled Select this option if the printer attached to this port supports RFC1759. This field
appears only if you select Standard TCP/IP as the port.

Community Name: Specify a community name, for example: public.

SNMP Device Index: Specify the device index, for example: 1.
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Field

Details

Install a Driver

Model Name

Driver File Path

Supported Platforms

Language of
Installation

Install Forcefully Even
if the Driver is Already
Installed

Select this option to install a driver on the target device. The driver installation
must be non-interactive and silent. The supported driver installation type is - inf
and the . inf driver files can be bundled in .zip or .tar formats. The . inf
file can be specified directly if it is already available on the target device. Ensure
that the . inf file supports the installation of the driver.

NOTE: To add a new printer driver to the existing driver list:

Edit the

zenworks_instal ldir\novel I\zenworks\share\tomcat\webapps\ze
nworks\WEB- INF\conf\printerDriverDetails.conf file to add the
following line:

Printer_ Manufacturername = Printer_ Model

For example, if you want to add an HP Color LaserJet 4550 PCL printer, then
add the following line:

HP = HP Color LaserJet 4550 PCL
Browse to select the model name of the driver.

Specify the driver files either from a particular device where the browser is
running or from a path on the managed device, such as C:\temp\nipp.zip.

NOTE: While configuring the policy, if you are using a UNC path to access the
Driver file, make sure the file you access must be on an anonymous share.

Specify a platform for the driver. The platform information helps to select a
suitable driver from the available drivers list, which is based on the installation
platform.

Select the installation language. Your choices are English (United States),
French, German, Portuguese, Spanish, Italian, Chinese (Traditional), Chinese
(Simplified), or Japanese.

Select this option to force installation of the driver, even though it is already
installed on the target device.

(Conditional) If you are configuring a Network printer, refer to the following table for more

information:

Field

Details

Name / Location

Driver

Specify the UNC path or URL name of the HTTP, SMB or CUPS printer.

For example, it is \\server-name\printer-name for an SMB printer,
http://server:631/printers/myprinter for a CUPS printer, or http://
server/printers/._myprinter/._printer for a HTTP printer.

NOTE: Support for network printer that prompts for user credentials is not
provided.

Browse to add and select a suitable driver for the Windows HTTP printer. You can
ignore this for SMB printers.

The driver must be digitally signed by Microsoft. However, if you choose to use a
driver that is not digitally signed, see the Troubleshooting Scenario
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Field Details

Install a Driver Use this option to install a driver on the target device. The driver installation is
non-interactive and silent. The supported driver installation types is . inT and the
- inf driver files can be bundled in .zip or .tar formats. The . inf file can be
specified directly if it is already available on the target device. Ensure that the
- inF file supports the installation of the driver.

NOTE: To add a new printer driver to the existing driver list:

Edit the

zenworks_installdir\novel I\zenworks\share\tomcat\webapps\ze
nworks\WEB- INF\conf\printerDriverDetails.conf fileto add the
following line:

Printer_ Manufacturername = Printer_ Model

For example, if you want to add an HP Color LaserJet 4550 PCL printer, then add
the following line:

HP = HP Color LaserJet 4550 PCL
Model Name Browse to select the model name of the driver.

Driver File Path Specify the driver files either from a particular device where the browser is running
or from a path in the managed device, such as c:\temp\nip.zip.

NOTE: While configuring the policy, if you are using a UNC path to access the
Driver file, make sure the file you access must be on an anonymous share.

Supported Platforms  Specify a platform for the driver. The platform information helps to select a
suitable driver from the available drivers list, which is based on the installation

platform.
Language of Select the installation language. Your choices are English (United States), French,
Installation German, Portugese, Spanish, Italian, Chinese (Traditional), Chinese (Simplified),

or Japanese.

Install Forcefully Even Select this option to force the installation of the driver on the device every time the
if the Driver is Already policy is applied on the device, even if the driver is already installed on the device.
Installed

11 (Conditional) If you are configuring an iPrint printer, refer to the following table for more
information:

On Windows Vista devices, you need to install the Novell iPrint client 5.04 or later.

Field Details

Name / Location Specify the URI name of the iPrint printer. For example, ipp://acme.com/
ipp/servername.

Update iPrint Printer Select this option to update the printer driver and to reinstall the printer driver

while Installing the Driver from the iPrint server while installing the iPrint printer.

ZENworks 11 SP3 Configuration Policies Reference



12

Field

Details

Install iPrint Client

iPrint Client Installer File
Path

Install Forcefully Even if
the Driver is Already
Installed

Configure iPrint Client

Proxy Server

Select this option to install the iPrint client on a target machine. The iPrint client
is not supported on 64-bit versions of Windows Server 2003.

The installation file can be either nipp.zip or nipp-s.exe, both of which are
capable of carrying out non-interactive silent installation.These files can be
uploaded from the machine where the browser is running.

To install the iPrint client, you cannot use a -exe file that does not support a
silent installation. For example, you cannot use a nipp.-exe file to install iPrint
client.

Allows to specify the path to the iPrint Client Installer (which installs the iPrint
client on the managed device).

+ On the Managed Device: Select this option to specify the path to the
iPrint client installer on the managed device.

+ Select from this Device: Select this option to add the iPrint client
installer as content with the policy. You can also distribute the iPrint client
installer along with the policy.

If the installer file path is a UNC path, the Novell iPrint Client dialog box is
displayed until the installation process completes. This process can be
perfomed only by users with administrative rights.

Select this option to force installation of the driver, even though it is already
installed on the target device.

Select this option to configure the iPrint proxy server.

If the workstations are located outside the physical firewall, you can use this
option to specify the proxy address followed by a (:) and the port number.

Specify the iPrint proxy server name. For example, http://
proxy .companyx.com:8080

Click Next to display the Printing Preferences page, then use the options to specify the
preferences. Refer to the following table for more information:

Field Details

Orientation Select this option to specify the paper layout for the printer, such as landscape or
portrait.

Duplex Printing Specify whether or not to print on both sides of the paper, if the printer has that
capability.

Collate Specify whether or not the printer should organize multiple copies of a document,

if the printer has that capability.

Print Quality Select the print quality. Select High quality, for the best possible resolution, or
select Low quality for lower resolution and lower quality.

Creating Windows Configuration Policies
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Field Details

Paper Source Specify the paper source for the printer. A source that is not listed in the standard
available list can also be specified, but it must be supported by the printer.
Information on supported paper sources is available in the printer documentation
or in the registry key
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows
NT\CurrentVersion\Print\Printers\printer-
name\DsDriver\printBinNames on a Windows machine.

Paper Size Specify the paper size for the printer. You can specify any paper size supported by
the printer, in addition to the options listed in the menu. Information on supported
sizes is available in the printer documentation or in the registry key
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows
NT\CurrentVersion\Print\Printers\printer-
name\DsDriver\printMediaSupported on a Windows machine, where a
printer is locally installed.

Click Next to display the Additional Printer Policy settings, then use the options to specify the
settings. Refer to the following table for more information:

Field Details
Set as Default Select this option to specify a printer as the default printer to which the print
Printer requests are sent if no other printer is specified by the user.

On a Windows 7 managed device, the assigned printer might be set as a default
printer on the device even if the Set as Default Printer option is not selected in the

policy.

Remove all Printers  Select this option to remove all printers that are not specified through the ZENworks
not Specified by Printer policy.

ZENworks Printer

Policies

Click Next to display the Summary page. Review the information and, if necessary, use the Back
button to make changes to the information on the Summary page.

This wizard allows you to configure only one printer. If you want to configure additional printers,
then configure them in the Details page after creating the policy.

(Conditional) Select Create as Sandbox, if you want to create the sandbox version of the policy.

Click Finish to create the policy now, or select Define Additional Properties to specify additional
information, such as policy assignment, system requirements, enforcement, status, and which
group the policy is a member of.

Only the preferences that are supported by the printer are configured on that printer.

NOTE: Upon unenforcement of a user-assigned printer, a user with administrative privileges
continues to have access to the local printer on a Windows XP managed device.
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3.7

Remote Management Policy

The Remote Management policy lets you configure the behavior or execution of a Remote
Management session on the managed device. The policy includes properties such as Remote
Management operations and security.

By default, a secure Remote Management policy is created on the managed device when the
ZENworks Adaptive Agent is deployed with the Remote Management component on the device. You
can use the default policy to remotely manage a device. To override the default policy, you can
explicitly create a Remote Management policy for the device.

For information on creating the Remote Management policy, see “Creating the Remote Management
Policy” in the ZENworks 11 SP3 Remote Management Reference.

Roaming Profile Policy

The Roaming Profile policy allows you to create a user profile that is stored in a network path. An
administrator can either use the roaming profile stored in the user’s home directory or the profile
stored in the network directory location.

On a Windows 8 machine, the Roaming Profile policy works when a user logs in through the Novell
Client.

IMPORTANT: Because of the security settings in Microsoft Vista, administrators must manually add
the appropriate security rights to the user registry hive to enable roaming profiles. For more
information, see Section 4.9, “Assigning a Roaming Profile Policy for a User Profile Stored on a
Windows, Linux, or NetWare Share,” on page 60.

1 In ZENworks Control Center, click the Policies tab.
2 In the Policies list, click New, then click Policy.
or
In the Policy Tasks, click New Palicy.
The Select Platform page is displayed.
3 Select Windows, then click Next.
The Select Policy Category page is displayed.
4 Select Windows Configuration Policies, then click Next.
5 Select Roaming Profile Policy as the Policy Type, then click Next.

NOTE: If you log into Windows Vista or Windows 7 by using a domain account, Roaming Profile
policy is not supported.

6 In the Define Details page fill in the following fields:

Policy Name: Provide a name for the policy. The policy name must be different than the name of
any other item (group, folder, and so forth) that resides in the same folder. The name you provide
displays in ZENworks Control Center.

Folder: Type the name or browse to and select the ZENworks Control Center folder where you
want the policy to reside. The default is /policies, but you can create additional folders to
organize your policies.

Administrator Notes: Provide a short description of the policy’s content. This description
displays in ZENworks Control Center.
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Click Next to display the Roaming Profile Policy page, then use the options to specify the
settings. Refer to the following table for more information:

Field Details

Store User Profilein  Select this option to load and save a user’s profile from the user’'s home directory as
User’'s Home specified in eDirectory.

Directory
This option is applicable only if the user object is in eDirectory. However, it is

currently not supported in Domain Services for Windows environment.

User Profile Path Select a UNC path to a user’s roaming profile. If you want to administer the policy on
more than one user object, use YUSERNAME% as the environment variable. In this
case, the environment variable is resolved with the logged-on username and the
user profile is loaded from the specified path.

Override Terminal  If a user is accessing a terminal server that has its own profile, enable this option to
Server Profile override the terminal server’s profile.

Click Next to display the Summary page. Review the information and, if necessary, use the Back
button to make changes to the information on the Summary page.

(Conditional) Select Create as Sandbox, if you want to create the sandbox version of the policy.

Click Finish to create the policy now, or select Define Additional Properties to specify additional
information, such as policy assignment, system requirements, enforcement, status, and which
group the policy is a member of.

3.8 SNMP Policy

The SNMP policy allows you to configure SNMP parameters on the managed devices.

1 In ZENworks Control Center, click the Policies tab.

In the Policies list, click New, then click Policy.

or

In the Policy Tasks, click New Policy.

The Select Platform page is displayed.

Select Windows, then click Next.

The Select Policy Category page is displayed.

Select Windows Configuration Policies, then click Next.

5 Select SNMP Policy as the Policy Type, then click Next.

In the Define Details page fill in the following fields:

Policy Name: Provide a name for the policy. The policy name must be different than the name of
any other item (group, folder, and so forth) that resides in the same folder. The name you provide
displays in ZENworks Control Center.

Folder: Type the name or browse to the ZENworks Control Center folder where you want the
policy to reside. The default is /policies, but you can create additional folders to organize your
policies.

Administrator Notes: Provide a short description of the policy’s content. This description
displays in ZENworks Control Center.

Click Next to display the SNMP Community Strings page. Refer to the following table for more
information:

ZENworks 11 SP3 Configuration Policies Reference



10

Field Details

Add a Community String Allows you to add a community string.
Community String Specify the name of the SNMP community string to be added.
Community Rights Allows you to administer rights for a selected community, such as Read

Only, Read & Write, Read & Create, and Notify.

Remove All SNMP Select this option to remove all the community strings that are not
Community Strings not specified through ZENworks SNMP policy.

specified by ZENworks SNMP

Policies

Send SNMP Authentication Select this option if you want to send authentication trap information.
Trap

This page allows you to add only one community string to the policy. If you want to add multiple
community strings, then configure them in the Details page after creating the policy.

Click Next to display the SNMP Default Access Control List page, then use the options to specify
the settings. Refer to the following table for more information:

Field Details

Allow SNMP Communication Select this option to specify whether SNMP communication is allowed
from any host or a list of predefined hosts.

Remove All SNMP Allowed Select this option to remove all the SNMP allowed hosts that are not
Hosts not Specified by specified through the ZENworks SNMP policy.
ZENworks SNMP Policies

Click Next to display the SNMP Trap Targets page, then use the options to specify the settings.
Refer to the following table for more information:

Field Details

Add a Trap Target Allows you to add a trap target for the SNMP service.

IP Address / Host Name Specify an IP address or host name of the target device.

Community String Specify a community string for the trap target defined in IP address/
Host name.

Remove All SNMP Trap Targets Select this option to remove all the trap targets that are not specified
Not Specified by ZENworks through the ZENworks SNMP policy.
SNMP Policies

This page allows you to add only one trap target to the policy. If you want to add multiple trap
targets, then configure them in the Details page after creating the policy.

Click Next to display the Default System Requirements for SNMP Policy page, then use the
options to specify the settings. Refer to the following table for more information:
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Field Details

Apply Policy Only if SNMP Select this option apply the SNMP policy only if the SNMP service
Service Exists On the Target exists on the target device. If the target device does not contain the
Device SNMP service, the SNMP policy cannot be fully applied or effective on

the target device.

Click Next to display the Summary page. Review the information and, if necessary, use the Back
button to make changes to the information on the Summary page.

(Conditional) Select Create as Sandbox, if you want to create the sandbox version of the policy.

Click Finish to create the policy now, or select Define Additional Properties to specify additional
information, such as policy assignment, system requirements, enforcement, status, and which
group the policy is a member of.

3.9 Windows Group Policy

The Windows Group Policy allows you to configure a Group Policy for Windows devices.

In ZENworks Control Center, click the Policies tab.

In the Policies list, click New, then click Policy.

or

In the Policy Tasks, click New Policy.

The Select Platform page is displayed.

Select Windows, then click Next.

The Select Policy Category page is displayed.

Select Windows Configuration Policies, then click Next.

5 Select Windows Group Policy as the Policy Type, then click Next.

In the Define Details page fill in the following fields:

Policy Name: Provide a name for the policy. The policy name must be different than the name of
any other item (group, folder, and so forth) that resides in the same folder. The name you provide
displays in ZENworks Control Center.

Folder: Type the name or browse to and select the ZENworks Control Center folder where you
want the policy to reside. The default is /policies, but you can create additional folders to
organize your policies.

Administrator Notes: Provide a short description of the policy’s content. This description
displays in ZENworks Control Center.

Click Next to display the Windows Group Policy Settings page, then use the options to specify
the settings. Refer to the following table for more information:
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Details

Select the Type of
Group Policy to Manage

With the Windows Group Policy, you can manage either a Local group or an
Active Directory group policy.

Before you can configure the Group Policy, you need to install a helper
application. Click Install the Group Policy Helper to install the novel I-
zenworks-grouppolicyhelper-11.x.x.x.msi, which is a Windows
installer package. This installation needs to be done only once. After the helper
is installed, clicking Configure launches the helper, which you then use to
configure or import a policy.

IMPORTANT: After installation, if the Group Policy helper addon does not show
up on the browser, then manually enable Group Policy helper on that browser.

+ Local Group Policy: Select this option to configure a Local Group policy.

To launch the group policy helper, click Configure. Configure or edit the
settings in the Local Group policy, then upload the configured policy to the
ZENworks Server.

+ Active Directory Group Policy: Select this option to use an Active
Directory Group policy.

To launch the group policy helper, click Configure. Import an Active
Directory Group policy created from Windows Server 2003 or Windows
Server 2008 Active Directory, then upload to the ZENworks Server. (You
cannot edit an Active Directory policy through ZENworks Control Center.)
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Field Details

Select the Configuration After you have adjusted the policy settings as you prefer, you can select how to
Settings to Be Applied  apply the settings to the managed device.

On the Managed Device ] ) ) )
Computer Configuration Select this option to apply the computer

configuration settings to the managed device.

+ Apply all settings: Select this option to apply all the computer
configuration settings to the managed device.

* Apply only security settings: Select this option to apply only the
security settings to the managed device.

However, if you select this option, the software restrictions in security
settings are not enforced on the device. To enforce the software
restrictions, select Apply all settings.

+ Apply all settings except security settings: Select this option to apply
all the computer configuration settings except for security settings to the
managed device.

IMPORTANT: During creation of a Group policy, if the value(s) of Security
settings on the machine where ZENworks Control Center is launched is
modified, then while restoring back the machine settings, the security setting(s)
having default state as NOT DEFINED (prior to creation of policy) does not get
restored.

User Configuration Select this option to apply the user configuration settings
to the managed device.

NOTE:

* The Computer Configuration settings from a user associated group
policy are not applied when the user logs into a Windows 2000 or
Windows 2003 Terminal Server.

+ Group Policy Objects get assigned to a device on a general refresh.
The Computer Configuration settings of a device-assigned Group Policy
Object remains in-effect on user logout.

Click Next to display the Summary page. Review the information and, if necessary, use the Back
button to make changes to the information on the Summary page.

(Conditional) Select Create as Sandbox, if you want to create the sandbox version of the policy.

Click Finish to create the policy now, or select Define Additional Properties to specify additional
information, such as policy assignment, system requirements, enforcement, status, and which
group the policy is a member of.

If the login/logoff scripts are configured in a user-associated group policy and the After
enforcement, force a re-login on the managed device, if necessary, then a relogin is forced and
the login scripts run when the user logs into the managed device again. The startup scripts from
a device-associated policy run only when the device reboots the next time.

The Group policy login scripts do not support the environment variables for users on Windows
Vista, Windows Server 2003, Windows Server 2008, Windows 7, and Windows Server 2008 R2.

The scripts configured through Active Directory group policy are not enforced on the device even
though the policy displays success in the ZENworks Adaptive Agent Policies page. For more
information see, Section A.14, “Windows Group Policy Troubleshooting,” on page 113.
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+ If you want to apply the security settings of the Windows Group policy on Windows XP SP1
or SP2 managed device, ensure that the device has Windows Hotfix KB897327 installed.
For more information about how to install the Hotfix, see the Microsoft Support Web site
(http://support.microsoft.com/KB/897327).

3.10 ZENworks Explorer Configuration Policy

The ZENworks Explorer Configuration Policy allows you to administer and centrally manage the
behavior and features of ZENworks Explorer.
1 In ZENworks Control Center, click the Policies tab.
2 In the Policies list, click New, then click Policy.
or
In the Policy Tasks, click New Policy.
The Select Platform page is displayed.
3 Select Windows, then click Next.
The Select Policy Category page is displayed.
4 Select Windows Configuration Policies, then click Next.
5 Select ZENworks Explorer Configuration Policy as the Policy Type, then click Next.
6 In the Define Details page fill in the following fields:

Policy Name: Provide a name for the policy. The policy name must be different than the name of
any other item (group, folder, and so forth) that resides in the same folder. The name you provide
displays in ZENworks Control Center.

Folder: Type the name or browse to and select the ZENworks Control Center folder where you
want the policy to reside. The default is /policies, but you can create additional folders to
organize your policies.

Administrator Notes: Provide a short description of the policy’s content. This description
displays in ZENworks Control Center.

7 Click Next to display the ZENworks Explorer Configuration Settings page, then use the options
to specify the settings. Refer to the following table for more information:

Field Details

Enable Folder View Use this option to display a folder list in the application window.

The values are Yes, No, and Unconfigured. If you select the value as
Unconfigured, the default value Yes is set on the managed device.

Expand the Entire Folder Use this option to expand the entire folder tree when the application window is
Tree opened.

The values are Yes, No, and Unconfigured. If you select the value as
Unconfigured, the default value No is set on the managed device.

Display Applications in Use this option to display the application list in Windows Explorer.

Windows Explorer ]
The values are Yes, No, and Unconfigured. If you select the value as

Unconfigured, the default value Yes is set on the managed device.
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Field Details

Name of Root Folder Use this option to change the name of the root folder.
Hide the Zicon in the Use this option to hide the ZENworks icon in the taskbar.
taskbar

The values are Yes, No, and Unconfigured. If you select the value as
Unconfigured, the default value No is set on the managed device.

Enable Manual Refresh  Use this option to specify whether manual refresh of applications is enabled
after starting ZENworks Explorer.

The values are Yes, No, and Unconfigured. If you select the value as
Unconfigured, the default value Yes is set on the managed device.

Allow Logout / Login as a Use this option to enable the user to log out and log in as a new user.

New User '
The values are Yes, No, and Unconfigured. If you select the value as

Unconfigured, the default value Yes is set on the managed device.

Show Progress Use this option to specify whether the progress of the bundle operations
should be displayed.

The values are Yes, No, and Unconfigured. If you select the value as
Unconfigured, the default value Yes is set on the managed device.

Show Default Use this option to specify whether the default notification should be displayed.

Notifications The notification is displayed when the content associated with a policy or a
bundle is downloaded on the device. For example, during the enforcement of
the Printer policy on a device, the following message is displayed in the
notification area of the device:

Downloading Files for Printer Policy

The values are Yes, No, and Unconfigured. If you select the value as
Unconfigured, the default value Yes is set on the managed device.

Start the ZENworks Use this option to specify whether the [All] folder should be displayed when
Explorer with the {All} ZENworks Explorer starts.

Folder Displayed ]
The values are Yes, No, and Unconfigured. If you select the value as

Unconfigured, the default value Yes is set on the managed device.

8 Click Next to display the Summary page. Review the information and, if necessary, use the Back
button to make changes to the information on the Summary page.

9 (Conditional) Select Create as Sandbox, if you want to create the sandbox version of the policy.

10 Click Finish to create the policy now, or select Define Additional Properties to specify additional
information, such as policy assignment, system requirements, enforcement, status, and which
group the policy is a member of.

3.11 Creating Policies by Using the zman Command

44

Line Utility

ZENworks Configuration Management allows you to create different types of policies, such as
Browser Bookmarks policy, Dynamic Local User policy, Local File Rights policy, and Printer policy.
Each policy has its own set of data and configuration settings. Because it is complex to pass the data
as arguments in the command line, the zman utility takes XML files as an input to create policies. You
can use exported XML files as a templates to create polices. To use the zman command line utility to
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create a policy, you must have a policy of the same type already created through ZENworks Control
Center and export it to an XML file. For more information on creating policies by using ZENworks
Control Center, see Chapter 3, “Creating Windows Configuration Policies,” on page 19.

For example, you can export a Browser Bookmarks Policy already created through ZENworks
Control Center into an XML file, then use it to create another Browser Bookmarks Policy by using
zman.

A policy can have file content associated with it. For example, the printer driver to be installed is a file
associated with the Printer policy.

Review the following sections to create a policy by using the zman command line utility:

¢ Section 3.11.1, “Creating a Policy without Content,” on page 45
¢ Section 3.11.2, “Creating a Policy with Content,” on page 47
+ Section 3.11.3, “Understanding the zman Policy XML File Format,” on page 48

Creating a Policy without Content

1 Create a policy in ZENworks Control Center.

For example, use ZENworks Control Center to create a Browser Bookmarks Policy called google
containing a bookmark to http://www.google.co.in.

2 Export the policy to an XML file by using the following command:
zman policy-export-to-file policy name policy_filename.xml

For example, export the google policy to google.xml by using the following command:
zman policy-export-to-file google google.xml

If you want to create a new policy with new data, continue with Step 3. If you want to create a
new policy with the same data as the google policy, skip to Step 4.

3 Modify the XML file according to your requirements.

For example, in google.xml, change the value of <URL> from http://www.google.co.into
http://www.yahoo.com in the browserbookmarkspolicy action of the Enforcement action set
and <PolicyData> element in both <Actions> and <PolicyData> elements as shown below.

<ns2:ActionSets>
<1d>879de60b7591b6F6aefac09fcd83db54</1d>
<Type>Enforcement</Type>
<Version>1</Version>
<Modified>false</Modified>
<Actions>
<1d>0ab9a1785370bcd38bc862bd2817abac</1d>
<Name>browserbookmarkspol icy</Name>
<Type>browserbookmarkspolicy</Type>
<Data>

<PolicyData xmIns="http://novell.com/zenworks/datamodel/objects/
policies™>

<BookmarksPolicyHandlerData xmlns=""">

<EnforcePolicy>
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<Bookmarks>
<Bookmark Type="url_string'>
<Name>Google</Name>
<Url>http://www.yahoo.com</Url>
<Folder>/</Folder>
</Bookmark>
</Bookmarks>
</EnforcePolicy>
</BookmarksPol icyHandlerData>
</PolicyData>
</Data>
<ContinueOnFai lure>true</ContinueOnFailure>
<Enabled>true</Enabled>

<Properties>StandaloneName=browserbookmarksenf; Impersonation=SYSTEM;</
Properties>

</Actions>
</ns2:ActionSets>

<ns2:ActionSets xmlIns:ns2="http://novell._com/zenworks/datamodel/objects/
actions" xmlIns="http://novell.com/zenworks/datamodel/objects/actions'>

<ld>4efa37c827cf0e8a8ac20b23a3022227</1d>

<Type>Distribution</Type>

<Version>1</Version>

<Modified>false</Modified>

<Actions>
<1d>27c4a42544210b3ac3b067fFf6aff2d5c</1d>
<Name>Distribute Action</Name>
<Type>Distribute Action</Type>
<ContinueOnFai lure>true</ContinueOnFailure>
<Enabled>true</Enabled>
<Properties />

</Actions>
</ns2:ActionSets>

<Applylmmediate>false</Applylmmediate>
<PolicyData>
<BookmarksPol icyHandlerData>
<EnforcePolicy>
<Bookmarks>

<Bookmark Type="url_string">

ZENworks 11 SP3 Configuration Policies Reference



<Name>Google</Name>
<Url>http://www.yahoo.com</Url>
<Folder>/</Folder>
</Bookmark>
</Bookmarks>
</EnforcePolicy>
</BookmarksPol icyHandlerData>
</PolicyData>

4 Create a new policy by using the following command:
zman policy-create new_policy _name policy xml_filename.xml
For example, to create a policy named yahoo, use the following command:
zman policy-create yahoo google.xml

3.11.2 Creating a Policy with Content

1 Create a policy in ZENworks Control Center.

For example, use ZENworks Control Center to create a Printer policy of type iPrint called iPrint
Policy that automatically installs an iPrint driver from the driver.zip file provided as the policy
content, and configures an iPrint printer on the device.

2 Export the policy to an XML file by using the following command:
zman policy-export-to-file policy_name policy_filename.xml
This creates policy_filename.xml and policy filename_ ActionContentinfo.xml files.
For example, export iPrintPolicy to iPrintPolicy.xml by using the following command:
zman policy-export-to-file iPrintPolicy iPrintPolicy.xml

The iPrintPolicy.xml and iPrintPolicy_ActionContentinfo.xml files are created. For
more information about ActionContentlInfo.xml, see Section 3.11.3, “Understanding the zman
Policy XML File Format,” on page 48.

If you want to create a new policy with new data, continue with Step 3. If you want to create a
new policy with the same data as iPrintPolicy, skip to Step 4.

3 Modify the iPrintPolicy.xml and iPrintPolicy_actioncontentinfo.xml files according to
your requirements.

For example, to create a new policy to configure and install another iPrint in the network with a
newer version of the driver, do the following:

+ Change all references of driver.zip to newDriver.zip in the <ActionSet> and the
<PolicyData> section of iPrintPolicy.xml, and in the <ActionSet> section of
iPrintPolicy_actioncontentinfo.xml.

+ Replace the name of the printer in the iPrintPolicy.xml file with the new name of the
printer.

A sample iPrintPolicy_actioncontentinfo.xml is shown below.

<ActionInformation>
<ActionSet type="Enforcement'>

<Action name="printer policy"” index="1">
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<Content>
<ContentFilePath>driver.zip</ContentFilePath>
</Content>
</Action>
</ActionSet>
</ActionInformation>

4 Create a new policy by using the following command:

zman policy-create new_policy _name policy xml_filename.xml --actioninfo
policy_name_actioncontentinfo.xml

For example, use the following command to create a policy called New_iPrintPolicy:

zman policy-create New_iPrintPolicy iPrintPolicy.xml --actioninfo
iPrintPolicy_ActionContentInfo.xml

Understanding the zman Policy XML File Format

The policy-export-to-file command serializes the policy information, which is stored in the
database, into an XML file. Each policy contains actions that are grouped into Action Sets,
Enforcement, and Distribution. An exported policy XML file contains information for the policy, such
as UID, Name, Path, PrimaryType, SubType, PolicyData, System Requirements, and information on
all Action Sets and their actions. The file does not include information about assignment of the policy
to devices or users.

A sample XML format template, WindowsGroupPolicy.xml, is available at /opt/novel 1/zenworks/
share/zman/samples/policies on a Linux server and in
ZENworks_Installation_directory:\Novel I\Zenworks\share\zman\samples\policies on a
Windows server.

NOTE: If the exported XML file contains extended ASCII characters, you must open it in an editor by
using UTF-8 encoding instead of ANSI coding, because ANSI coding displays the extended ASCII
characters as garbled.

When you create a policy from the XML file, zman uses the information specified in the
<Description>, <SubType>,<Category>, <ActionSets>, <PolicyData>, and <SysRegs> tags of the
file. The values for the Name and Parent folder are taken from the command line. For the remaining
elements, the default value is used.

Follow the guidelines listed below to work with the XML file:
+ |If you want to create a policy without file content, you need only the policy XML file to create the
policy.
For example, a Local File Rights Policy does not have file content associated with it.

+ If you want to create a policy with content, you must provide an additional XML file, which
contains the path of the content file, as an argument to the -—actioninfo option of the policy-
create command.

For example, a Printer policy can have the printer drivers to be installed as associated file
content.
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A sample XML format template, ActionInfo.xml, is available at /opt/novell/zenworks/
share/zman/samples/policies on a Linux server and in

ZENworks_Instal lation_directory:\Novel I\Zenworks\share\zman\ samples\policies
on a Windows server.

If you want to modify the <Data> element of actions in the exported XML file, ensure that the new
data is correct and that it conforms to the schema. The zman utility does a minimal validation of
the data and does not check for the errors. Hence, the policy might be successfully created, but
with invalid data. Such a policy fails when deployed on a managed device.

File content is associated with a particular action in an Action Set. The Action Content
Information XML file should contain the path of the file to which the file content is to be
associated and the index of the action in the Action Set.

For example, the Printer driver selected to be installed when creating a Printer policy is
associated to the printerpolicy action in the Enforcement action set of the created Printer policy.

The Action Set is specified by the type attribute in <ActionSet> element. It should be the same
as the Action Set type of the policy XML file.

The <Action> element has a name attribute, which is optional, for user readability.

The index attribute is mandatory. It specifies the action to which the content should be
associated to. The index value of the first action in the Action Set is 1.

Each action can have multiple <Content> elements, each containing a <ContentFi lePath>
element. The <ContentFilePath> element contains the path of the file content to be associated
with the Action. Ensure that the filename is the same as the filename specified in the policy XML
file in <Data> for that action.

Ensure that the order of the <Content> elements is in accordance with the order in the policy
XML file. For example, a Printer Policy can have multiple drivers configured.The path to the
driver files should be specified in the <Content> elements in the order the files are specified in
the data for the action as show below.

<ActionInformaion>

<ActionSet type="Enforcement'>
<Action name="printer policy"” index="1">
<Content>

<ContentFilePath>driverl.zip</ContentFilePath>
</Content>
<Content>
<ContentFilePath>driver2._zip</ContentFilePath>

</Content>
</Action>

</ActionSet>

</Actionlnformation>
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Managing Policies

Novell ZENworks 11 SP3 Configuration Management lets you use effectively manage software and
content in your ZENworks system. In addition to editing and deleting existing objects, you can create
new objects and perform various tasks on the objects.

You can use ZENworks Control Center or the zman command line utility to manage policies. This
section explains how to perform this task by using ZENworks Control Center. If you prefer the zman
command line utility, see “Policy Commands” in the ZENworks 11 SP3 Command Line Utilities
Reference.

+ Section 4.1, “Creating Policies,” on page 52

¢ Section 4.2, “Viewing the Policy’s Summary,” on page 52

+ Section 4.3, “Policy Groups,” on page 55

+ Section 4.4, “Editing Policies,” on page 55

+ Section 4.5, “Deleting Policies,” on page 56

+ Section 4.6, “Adding Policies to Groups,” on page 57

+ Section 4.7, “Assigning a Policy to Devices,” on page 58

+ Section 4.8, “Assigning a Policy to Users,” on page 59

+ Section 4.9, “Assigning a Roaming Profile Policy for a User Profile Stored on a Windows, Linux,
or NetWare Share,” on page 60

¢ Section 4.10, “Assigning a Roaming Profile Policy for a User Profile Stored on a Home
Directory,” on page 63

+ Section 4.11, “Assigning the Local File Rights Policy to Devices Running Different Languages,”
on page 63

¢ Section 4.12, “Unassigning a Policy from Devices,” on page 64

¢ Section 4.13, “Unassigning a Policy from Users,” on page 64

¢ Section 4.14, “Adding System Requirements for a Policy,” on page 64

+ Section 4.15, “Disabling Policies,” on page 71

¢ Section 4.16, “Enabling the Disabled Policies,” on page 71

+ Section 4.17, “Copying a Policy to a Content Server,” on page 72

+ Section 4.18, “Publish a Policy,” on page 73

+ Section 4.19, “Reviewing the Status of the Policies at the Managed Device,” on page 74

¢ Section 4.20, “Policy Issues on a Windows 7, Windows Server 2008, or Windows Server 2008
R2 device,” on page 75

+ Section 4.21, “Viewing the Predefined Reports,” on page 76

¢ Section 4.22, “Understanding Policy Versions,” on page 76

+ Section 4.23, “Managing Policy Versions,” on page 77

¢ Section 4.24, “Publishing a Sandbox,” on page 78

+ Section 4.25, “Policy Behavior Based on Content Replication Settings,” on page 79
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Creating Policies

For step-by-step instructions on cre